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1       UVOD U LINUX
1.1     Operativni sistemi

Kao i računari i softver je prevalio dugačak put od početka svog razvoja do danas. Posebno mesto u tom razvoju imaju operativni sistemi, kao najvažnija karika u savladavanju jaza između čoveka i mašine, odnosno onaj njihov deo koji se naziva korisnički interfejs. Korisnički interfejs je skup pravila i načina razmenjivanja informacija, kojima se daje forma uzajamnoj komunikaciji korisnika i računara
Pod pojmom operativnog sistema u klasičnom smislu podrazumeva se "softver potreban za izvršavanje (aplikativnih) programa i za koordinaciju aktivnosti računarskog sistema. Taj softver može obuhvatati procedure raspodele resursa računarskog sistema, kontrole ulazno-izlaznih operacija, upravljanja memorijom, upravljanja podacima, prevođenja programskih jezika itd.". Iz ove se definicije vidi da ona polazi od koncepcije računara opšte namene kao jedino moguće arhitekture računarskog sistema. Upravo zbog toga ona među funkcije operativnog sistema uključuje i funkciju prevođenja programskih jezika. Međutim, trend specijalizacije elektronskih računara imao je kao posledicu modifikaciju definicije operativnog sistema, što se uočava iz sledeće definicije: "Pojam operativnog sistema obuhvata one programske module u računarskom sistemu pomoću kojih se realizuje kontrola hardverskih resursa, ulazno-izlaznih uređaja i datoteka. Ti moduli razrešavaju konflikte, pokušavaju da optimizuju funkcionisanje i pojednostave upotrebu računarskog sistema. Operativni sistem, dakle, deluje poput posrednika između korisničkih programa i fizičkog računarskog hardvera." Takvo određenje operativnog sistema neosporno ukazuje na njegovo poimanje u funkciji bazičnog sistemskog softvera. Može se reći da je Operativni sistem program namenjen da zajedno sa hardverom računara obezbedi upotrebljiv računarski sistem. Pod tim se podrazumeva da operativni sistem treba da obezbedi korisniku udobno radno okruženje i korišćenje resursa računara na najbolji mogući način. Pored ovih, on vrši i kontrolnu funkciju - kontroliše da li se računar koristi na odgovarajući način i sprečava eventualne greške. Operativni sistem često vodi i evidenciju korišćenja resursa, događaja na sistemu, otkaza sistema i sl.

Najčešće se operativni sistem i definiše prema mestu koje zauzima: Operativni sistem je skup programa koji predstavljaju interfejs između korisnika i hardvera računarskog sistema.

Mesto operativnog sistema u okviru računarskog sistema se može prikazati na sledeći način:



Polazeći od druge navedene definicije, funkcijama operativnog sistema treba smatrati: 

· funkcije upravljanja memorijom računara 

· funkcije upravljanja centralnim procesorom računara 

· funkcije upravljanja periferijskim uređajima 

· funkcije upravljanja podacima, odnosno informacijama

· procedure optimizacije kompleksa navedenih funkcija. 

Sa stanovišta operativnog sistema svi hardverski uređaji, izuzev procesora i memorije, predstavljaju periferiju ili periferijske uređaje računarskog sistema. Radom tih uređaja upravlja određeni skup modula operativnog sistema, čiji je osnovni zadatak, dakle, upravljanje periferijskim uređajima, kojih u nekim konfiguracijama može biti vrlo mnogo.
1.2     Mesto Linuxa

Operativni sistem Linux predstavlja varijantu UNIX-a koja je stvorena sa idejom da ovaj softver može da se koristi i dograđuje besplatno. Linux su za samo nekoliko godina postojanja prihvatili programeri, a zatim i drugi korisnici. Danas ovaj operativni sistem ima značajnu primenu.Linux je besplatan, a pri tome veoma pouzdan što je razlog njegove sve veće popularnosti kod miliona korisnika širom sveta.

On podržava i komandni i grafički način rada, omogućava istovremeno izvršavanje više programa. Takođe, to je višekorisnički operativni sistem sa jakim sistemom zaštite podataka od neovlašćenog korišćenja.Linux je UNIX like operativni sistem, koji je kreirao Linus Torvalds, student iz Finske. Linux je jedan je od retkih sistema koji je doživeo veliki uspeh i popularnost kao alternativa skupim i nedovoljno stabilnim sistemima. Linuxu se ubrzo priključio veliki broj programera iz celog sveta, kojima se dopao projekat. Za nekoliko meseci, na hiljade ljudi je radilo na razvoju Linux kernela preko Interneta. 

Odgovor na pitanje "Šta je Linux?" je vrlo jednostavan - Linux je kernel, srž sistema koji upravlja radom računara, memorijom, perifernim uređajima, pokreće programe i slično. Linux distribucije su, u stvari, kompletna aplikativna rešenja bazirana na Linux kernelu. Pošto je Linux UNIX klon, dosledno prati UNIX filozofiju rada. To je multitasking, višekorisnički 32-bitni operativni sistem, prvobitno zamišljen samo za Intel x86 arhitekturu. Naravno, potpuno je besplatan, i dolazi u source obliku. Upravo zbog tih razloga je stekao ogromnu popularnost prvo među studentima i programerima, a kasnije kod svih ostalih korisnika računara.

Većina ljudi imaju mišljenje da je Linux isključivo upotrebljiv kao server sistem na Internetu ili Intranet mreži. Delimično su u pravu, jer se Linux pokazao kao odličan server sistem. Ali, Linux sistem je izuzetno upotrebljiv i kao razvojna platforma (zahvaljujući ogromnom broju razvojnih alata), biznis platforma (zbog velikog broja Office paketa izuzetne upotrebljivosti), radna stanica, multimedijalna a vrlo brzo i platforma za zabavu (zahvaljujući odličnom engine-u za razvoj video igara). Takođe, ako ne postoji neka aplikacija za Linux, ona se uspešno može pokrenuti pod velikim brojem OS emulatora koji emuliraju rad ostalih operativnih sistema (DOS, Windows, MacOS, AmigaOS i ostali).

Prve verzije sistema baziranih na Linux kernelu su bile vrlo odbojne običnim korisnicima zbog vrlo komplikovanog (tekstualnog) interfejsa. Situacija se znatno izmenila poslednjih godina, zbog moćnog X Window grafičkog podsistema, vrlo efektnog i intuitivnog GUI interfejsa. Najpoznatiji GUI sistemi za Linux su svakako GNOME i KDE, oba izuzetno jednostavna i u isto vreme veoma moćna okruženja.

 1.3    Distribucije Linuxa
Danas postoji mnoštvo distribucija (varijanti) Linux-a. Ono što je zajedničko za sve Linux distribucije je da sadrže Linux kernel, i kao dodatak sve sadrže GNU programe, X-Window system,Apache web server i još mnogo programa koji svaku od njih čini funkcionalnim operativnim sistemom. Glavna razlika između pojedinih distribucija je u instalaciji i konfigurisanju sistema. Distributeri Linux-a su napravili različite programe koji korisniku omogućavaju lakši proces instalacije. Najpoznatije distribucije su: Slackware, Red Hat, Debian, SuSe, Mandrake,Knoppix itd.

SLACKWARE

Slackare je jedna od najstarijih distribucija Linux-a koja je uživala veliku popularnost sve do pojave Red Hat distribucije. Osnovne karakteristike ove distribucije su: pouzdanost, stabilnost i sigurnost. Slackware važi za legendu i merilo za ostale distribucije
RED HAT

To je jedna od najstarijih i najzastupljenijih distribucija. Veoma je popularna zbog olakšane instalacije, gde korisnik samo bira šta želi instalirati (ili deinstalirati), vrlo lakog upgrade-a preko interneta i sličnih detalja. Ova distribucija koristi Red Hat Package Manager (RPM) koji omogućava instaliranje i deinstaliranje, aplikacija i komponenti operativnog sistema.

DEBIAN 
Debian distribucija se razlikuje od drugih po tome što iza nje ne stoji nijedna konkretna firma  koja je podržava, već na njenom razvoju radi veliki broj volontera. Poseduje svoj package manager (deb). Popularna je prvenstveno kod iskusnijih korisnika.

SuSE
Ovo je nemačka distribucija nastala kao klon Red Hat-a. Spada u vodeće evropske distribucije, a karakteriše je veliki broj softvera i ogromna dokumentacija. Omogućava lak prelazak sa Windowsa na Linux.

MANDRAKE

Ovo je francuska distribucija, nastala po uzoru na Red Hat. Pogodna je za početnike koji prelaze sa Windowsa na Linux.  Mandrake je razvio Drak čarobnjake za konfigurisanje svih delova sistema.

KNOPPIX

Knoppix se razlikuje od drugih distribucija potome što se ne instalira na hard disk. Pokreće se direktno sa CD-a.Pogodna je za one koji žele brzo i lako da isprobaju Linux, ali je dalja instalacija nemoguća.

1.4      Instalacija Linux SuSE 8.1
Za instalaciju Linux SuSe 8.1 potrebni su instalacioni diskovi kojih za ovu distribuciju Linux-a ima 5. Prvo što se mora uraditi je da se u BIOS-u računar podesi da prvi uređaj za učitavanje operativnog sistema bude CD-ROM, pa tek onda hard disk. Posle toga se prvi instalacioni disk ubacuje u CD-ROM. Linux operativni sistem će automatski pokrenuti nekoliko programa koji prepoznaju arhitekturu računara i izvršavaju instalaciju operativnog sistema. Postupak koji je ovde naveden najčešće je u upotrebi, tj. namenjen je neiskusnim korisnicima. 
Posle ubacivanja prvog instalacionog diska i podizanja sistema na monitoru se pojavljuje pozdravna poruka SuSe-a.

Na sledećem dijalog prozoru korisniku se nudi nekoliko opcija o vidu instalacije, testa ispravnosti memorije ili pokretanje alata za popravku sistema koji se već nalazi na računaru. Pošto se ovde radi o instalaciji treba da se izabere opcija “Installation” 
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                Slika 1.2: Boot from hard disk                                    Slika 1.3: YaST2
Zatim se pokreće YaST2- instalacioni sistemski program. U ovom dijalog prozoru se nudi opcija izbora jezika na kome će biti izvršena instalacija.

Korisniku se potom nudi da podesi neke od osnovnih parametara njegovog  računara. YaST nudi neka rešenja, ali ih korisnik može promeniti i prilagoditi svojim potrebama. Da bi se izvršila promena  treba kliknuti na naslov (Mouse, Keyboard layout ....) ili na meni Change...
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Slika 1.4: Instalaciona podešavanja 1                         Slika 1.5: Instalaciona podešavanja 2

Opcija Partitioning omogućava podelu diska na particije. 

Software je opcija za odabir softvera koi želimo da instaliramo.

Booting je opcija za podešavanje programa za učitavanje operativnog sistema – „ boot loader“

Language – je opcija za izbor jezika 

Time zone – opcija za podešavanje vremenske zone 

                                              [image: image5.jpg]Instalkstion Settings

Mwymtommmotmm'cw " e fetoy,

{

Languags
Sebestion
: & Bont Inacks type: GRUEB
P e Leoation: 1. SOSL 3.00 GB. /devisds, Vidware Vidwars Virual
Installation .« Zeutions: linux idstautlty, flepey. fallsafs, memtsstss

{ Time zone

. CICH Comwor O!! Tm

® UBA / Pacific - Hardware slock ssl 1o UTS 0801100 - 10-054-2004

f
Perform ! Language
healation | onade

* English iUs;
Helg __Abeoyl Inctallation |





                                                    Slika 1.6: Instalaciona podešavanja 3

Da bi se instalacija Linux-a izvršila na odgovarajući način potrebno je poznavati postupak instalacije, naročito ako korisnik hoće da ima instalirano nekoliko operativnih sistema na svom računaru. Particionisanje hard diska je veoma važan korak u instalaciji operativnog sistema. Klikom na opciju Partitioning, YaST nudi rešenje za particionisanje, koje korisnik može prihvatiti ili odbaciti. Prilikom particionisanja treba poznavati neke osnovne pojmove. Linux sistem označava diskove u računaru kao /dev/hda, /dev/hdb, /dev/hdc za prvi IDE disk ,odnosno drugi, treći. Takođe, označava sa /dev/sda, /dev/sdb, /dev/sdc SCSI diskove. Diskovi se dalje dele na particije, tako da operativni sistem koristi svaku particiju nezavisno od drugih, kao zasebni disk. Treba još imati u vidu da za rad Linux-a treba obezbediti i jednu swap particiju, koja služi kao produžetak fizičke memorije računara i sa njom čini virtuelnu memoriju. veličina swap particije zavisi od načina korišćenja računara. U daljem toku particionisanja, poznavajući sve gore navedeno, treba samo pratiti dijalog prozore YaST-a i dovesti particionisanje do kraja, onako kako korisnik želi.

Klikom na opciju Software, otvara se dijalog prozor koji nas vodi kroz podešavanje instalacije softvera. YaST nam omogućava da izaberemo koje ćemo sve softvere ubaciti u opciju za instalaciju. Ovde treba naglasiti da, ako se nešto u startu propusti, instalacija softvera se može izvršiti ili dopuniti i kasnije prilikom rada.

Klikom na opciju Booting korisniku se omogućava da izabere koji će se program koristiti prilikom učitavanja operativnog sistema „boot loader“ (LILO ili GRUB). 

Kada je korisnik zadovoljan svim podešavanjima  treba još samo da pokrene instalaciju klikom na dugme „accept“. Otvara se dijalog prozor koji obaveštava korisnika da ukoliko nastavi sa instalacijom sve promene u računaru biće trajne. Klikom na dugme „Yes, install“ pokreće se instalacija.

U daljem toku instalacije YaST obaveštava korisnika o toku instalacije, ali korisnik neće biti u mogućnosti da utiče na definisane parametre. Ono što korisnik može da uradi, to je da može samo da prekine instalaciju. 
Tok instalacije je sledeći: YaST pravi particije, onako kako je korisnik to definisao, a zatim prelazi na instalaciju softvera. Softverski paketi se učitavaju sa prvog instalacionog diska i posle završetka tte instalacije sistem se restartuje i traži od korisnika drugi instalacioni disk, a zatim, u zavisnosti od izbora softvera, tražiće i druge instalacione diskove.
                                         [image: image6.jpg]-Current Package

- Installation
Remaining
I % cDi
cp2 734 MB

CD3;
CD 4
GD5:
oo
YaST2 <2> Total 7.34MB

Insert
'SUSE Linux Version 8.2' CD 2
| Show details

Abort || Skip | | Eject

Installation Log (Extract)

LBack.] Refbortad Ll )





                                                Slika 1.22 Instalacija paketa 

Veoma bitna stavka u instalaciji Linux-a dolazi posle instalacije softvera, a to je definisanje lozinke za root administratora. Ono što je ovde veoma važno je da se root lozinka ne sme zaboraviti, jer će u protivnom sistem biti neupotrebljiv.
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                                                    Slika 1.24    Novi  korisnik
Upisivanje običnih korisnika može se obaviti u toku instalacije, a dodavanje korisnika  može se izvršiti i kasnije, nakon završene instalacije. Pored dodavanja novih korisnika na sistem mogu se definistati njegova prava na sistemu. Konfigurisanje mreže, mrežnih resursa, interfejsa, modema, grafičke karte, štampača, zvuka itd.mogu se izvršiti i kasnije prilikom korišćenja sistema.
Nakon završetka instalacije klikom na dugme Finish SuSE će se startovati.
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         Slika  1.28   Logovanje                               Slika 1.29  Odabiranje okruženja

Pre prijavljivanja na sistem korisnik može da odabere grafičko okruženje u kome će raditi 

Nakon završetka rada korisnik se odjavljuje sa sistema i isključuje računar. Prilikom ponovnog stratovanja računara, korisniku se nudi izbor sa kog mesta će učitati operativni sistem (GRUB boot loader). Na ovom meniju se nalaze i svi ostali operativni sistemi koji se nalaze na računaru.
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                                          Slika 1.34   Izbor učitavanja sistema
2 SISTEM UPRAVLJANJA DATOTEKAMA, YaST(Yet another SistemTool), PODRŠKA MULTIMEDIJIMA, ZAŠTITA PODATAKA 

Operativni sistem Linux napravljen je da ga mogu koristiti više korisnika u isto vreme. Pri tome su svi podaci i dokumenti potpuno zaštićeni od namernog ili slučajnog brisanja, čitanja i zloupotrebe. Ovo se postiže tzv. „korisničkim nalozima“. Svakom korisniku se dodeljuje po jedan korisnički nalog  koji mu daje određena ovlašćenja na sistemu, ali i koji mu nameće određena ograničenja. Korisnički nalog se sastoji od korisničkog imena „user name“ koje je javno i lozinke „password“ koju sme da zna samo korisnik. Sigurnost lozinke obezbeđuje sigurnost podataka na računaru. Različiti korisnici se razlikuju i po pravima koja poseduju na sistemu. Postoje sistemski korisnici i obični korisnici. Daleko veća ovlašćenja na sistemu imaju sistemski korisnici koji imaju prava da ubacaju i uklanjaju hardver, aplikacije, upravljačke programe itd. Obični korisnici imaju prava samo da koriste postojeće resurse računara.

2.1   Prijavljivanje na sistem, korisnički nalozi 
Prilikom pokretanja operativnog sistema korisnika dočekuje dijalog prozor za logovanje na sistem. U tom dijalog prozoru korisnik mora da unese svoje korisničko ime (user name), lozinku (password), kao i mogućnost da odabere grafičko okruženje u kom će raditi. Da bi sve ovo bilo moguće korisnik mora posedovati korisnički nalog ili se mora obratiti administratoru da mu dodeli korisnički nalog.

Da bi administrator dodao novi korisnički nalog mora se prijaviti na sistem kao root pošto jedino on ima ovlašćenje da dodeljuje korisničke naloge. Da bi se jedan korisnički nalog dodao mora se pokrenuti YaST kontrolni centar, aplikacija za administratorska podešavanja sistema. Jedna od opcija kontrolnog centra je i dodavanje novih korisničkih naloga ( Edit and create users)
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              Slika 2.1 Putanja do YaST-a                   Slika 2.2   YaST kontrolni centar

Praćenjem dijalog prozora može se dodati novi korisnički nalog, izmeniti postojeći korisnički nalog, izbrisati  postojeći korisnički nalog  itd. Prilikom dodavanja novog korisničkog naloga, novom korisniku se dodeljuje korisničko ime, lozinka, kao i njegove mogućnosti na sistemu (pristup internetu, koje resurse sistema može koristiti itd.).
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                                           Slika 2.3  Dodavanje novog korisnika

Na predhodnoj slici se vidi da se lozinka mora ukucati dva puta u različita polja, kao potvrda da se nije desila greška u kucanju, jer se lozinka ne vidi na ekranu već samo tačkice. nakon svih ovih podešavanja klikne se dugme Create da bi se novom korisniku dodelio korisnički nalog.
2.2  / home direktorijum
Svaki korisnik standardno dobija po jedan direktorijum na sistemu koji pripada samo njemu i kome samo on ima pristup. Na tom mestu može standardno da instalira aplikacije koje će samo on moći da koristi i u koje će smeštati svoje podatke i dokumenta. Korisnik može da izvrši podešavanja sistema prema svojim potrebama. To se postiže tako što se specifični konfiguracijski fajlovi koji se odnose samo na jednog korisnika snimaju u njegov home direktorijum. Slično je i sa ostalim podešavanjima koja se odnose na jednog korisnika (desktop, veličina panela, jezička podešavanja itd.)
2.3    Menadžer datoteka (Konqueror)
Menadžer datoteka je jedan od najvažnijh programa svakog operativnog sistema. U početku je menadžer datoteka služio za pregled sadržaja operativnog sistema, kao i obavljanje jednostavnih operacija nad datotekama. Kako su se operativni sistemi razvijali, tako je menadžer datoteka dobijao dodatne funkcije, nikad ne napuštajući svoju osnovnu, a to je rad sa datotekama.

U Linux SuSE 8.1 menadžer datoteka je Konqueror (Osvajač) koji pokrećemo tako što kliknemo ikonu korisničkog direktorijuma.
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                                   Slika 2.4  Konqueror menadžer datoteka  
Prozor menadžera datoteka sadrži sledeće elemente:

1. okviri za navigaciju i pregled sadržaja

2. polje za adrese

3. navigacioni meni

4. komande

5. ikone najčešće korišćenih komandi   
2.3.1   Okviri za navigaciju i pregled sadržaja
Menadžer datoteka ima funkciju da omogući korisniku da se lako snalazi na operativnom sistemu, brzo pronađe svoje datoteke ili pregleda strukturu svog sistema. Podređen tom zadatku, ovaj program je oblikovan tako da što bolje i razumljivije pokaže sadržaj i omogući operacije nad tim sadržajima. Dva su osnovna okvira menadžera datoteka:

a) okvir za navigaciju

b) okvir za pregled sadržaja 
Okvir za navigaciju je obično manji od ova dva. Sadrži listu direktorijuma, koji su predstavljeni ikonama sa slikom fascikle, po čemu ih prepoznajemo. Lista je u obliku stabla, a svako stablo ima koren. U Linux-u se koren označava sa kosom crtom (/). To je najviši nivo i iznad njega ne mogu postojati podaci.

Kada u okviru za navigaciju kliknemo na neki direktorijum, u okviru za pregled sadržaja će se pokazati šta ima u njemu. Ako direktorijum na koji smo kliknuli sadrži direktorijume, ili datoteke, ili 

jedno i drugo, sve to će biti prikazano u ovom okviru.
2.3.2     Polje za adrese

Ovo polje je još jedan način, ovoga puta tekstualni, da saznamo gde se nalazimo na sistemu. U ovo polje takođe možemo da sa tastature ukucamo putanju do mesta koje želimo da posetimo.

2.3.3     Navigacioni meni

Ovaj element predstavlja posebno odličje Konqueror menadžera datoteka. Njime se okviru za navigaciju daju veće mogućnosti. On prestaje da bude samo alatka za kretanje po sistemu, već omogućava i brz pristup omiljenim adresama na lokalnoj mreži, Internetu ili podešavanju perifernih uređaja, kao što su CD-ROM diskovi ili štampači.

2.3.4     Komande

Komande se javljaju u obliku padajućih menija klikom na pojedine u komandnoj liniji. Nećemo ih posebno razjašnjavati zato što ih  ima mnogo, ali su vrlo korisne i svaki korisnik bi trebao znati njihove funkcije.

2.3.5    Ikone najčešće korišćenih komandi

Pošto postoji zaista veliki broj komandi koje su grupisane u tekstualne menije, ukazala se potreba da za bržim pristupanjem onima koje se najčešće koriste. Zbog toga su ove komande 

izdvojene u posebnom delu programa.
Neki od Linux direktorijuma:

/bin  -  brojni standardni izvršni programi koji služe za održavanje sistema, podešavanje hardvera, mrežnih resursa, administraciju korisnika itd.

/boot  -  u njemu se nalazi kompajlirani kernel. Učitava se prilikom podizanja sistema.

/dev  -  direktorijum u kome status je status uređaja prikazan u formi fajlova. Ovde se može videti tip procesora, sadržaj memorije i hard diska, tip modema i ostalih uređaja

/etc -  služi za smeštanje najrazličitijih konfiguracionih fajlova. 

/home  -  korisnički direktorijumi

/lib  -  razne deljene biblioteke

/root  -  home direktorijum administratora sistema

/usr  -  korisničke aplikacije treba smeštati i tražiti ovde

2.4    Dozvole pristupa
Korisnik ima mogućnost da svakom direktorijumu ili fajlu dodeli dozvole pristupa za ostale korisnike. Reč je o tri sekcije od po tri znaka koji u potpunosti definišu ko može da čita, upisuje/briše/menja i izvršava datoteke. Prva sekcija (prva tri znaka) odnosi se na vlasnika fajla ili direktorijuma. Druga sekcija (druga tri znaka) odnosi se na pripadnike grupe kojoj pripada fajl ili direktorijum. Treća sekcija (treća tri znaka) odnosi se na sve ostale korisnike koji nisu obuhvaćeni predhodnim dvema grupama.

Svaka grupa se sastoji od tri znaka dozvola: rwx
r (read)- ovaj znak znači da je dozvoljeno čitanje sadržaja fajla ili direktorijuma

w (write)- ovaj znak dozvoljava upisivanje, izmenu i brisanje fajla

x (execute)- ovaj znak dozvoljava izvršavanje fajla ili ulazak u direktorijum
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                                           Slika 2.5  Dozvole pristupa      
2.5      Zaštita podataka

Kao jedan od najjednostavnijih programa za zaštitu privatnosti podataka jeste grupa programa GnuPG-GNU Privacu Guard. Njegov algoritam za šifrovanje podataka je u javnom vlasništvu. Najčešće korišćen program iz ove grupe je gpg, i koristi se za šifrovanje podataka. Ovaj program je za rad u tekstualnom režimu, a njegov ekvivalent za rad u grafičkom okruženju je je program KGpg. KGpg je dobro integrisan i u Konqueroru tako da je šifriranje i dešifriranje moguće i iz njega. Princip rada ovog programa zasniva se na paru ključeva. Prvi ključ služi za šifriranje podataka. On se naziva i javni ključ- Public Key. Ovaj ključ se javno deli svim interesentima koji imaju želju da korisniku šalju poverljive podatke. Drugi ključ je tajni- Secret Key. Ovim ključem se dešifruju podaci i on mora biti čuvan u tajnosti. Sa njime se mogu pročitati podaci koji su šifrirani isključivo odgovarajućim javnim ključem. Važi i obratno, podaci šifrirani javnim ključem mogu se dešifrovati samo odgovarajućim tajnim ključem. Program se pokreće putanjom Glavni meni→Pokreni komandu gde se otkuca kgpg. Posle pojavljivanja ikone klikom na nju, iz nje se izabere „Open key manager“. Izabira se dijalog za generisanje para ključeva preko putanje Keys →Generate Key Pair. Posle upisivanja svojih podataka otvara se dijalog za unos tajnog ključa.Tajni ključ mora da se unese u dva polja radi zaštite od grešaka u kucanju.
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                 Slika 2.6 kgpg                                 Slika 2.7 Dijalog za unos tajnog ključa

Svoj javni ključ korisnik može objaviti preko Keys →Export Public Key tako što se izabere ime fajla u koji će biti upisan javni ključ i potom poslati ovaj fajl svim zainteresovanim prijateljima koji će uz pomoć njega šifrirati podatke namenjene samo njemu. Ukoliko vam neko pošalje svoj javni ključ njega možete sačuvati uz pomoć putanje Keys  →Import Key. Ovim ključem šifrujete podatke koje će moći da dešifruje samo korisnik koji je vlesnik odgovarajućeg tajnog ključa.

Procedura slanja šifriranih podataka je sledeća: klikom na ikonu KGpg-a na panelu otvara se dijalog prozor, a u njemu izabira Open Editor. Ovde uvozimo tekst koji želimo da šifriramo i klikom n adugme Encrypt tekst će biti šifriran. Snim ase i šalje vlasniku odgovarajućeg tajnog ključa koji će ga moći dešifrovati i pročitati. Uz pomoć KGpg-a mogu se šifrovati i dešifrovati slike, video snimci, programi i sve informacije u digitalnom obliku. U Konqueroru desnim klikom miša na bilo koji fajl i izborom opcije Encrypt otvoriće se dijalog u kome se može birati javni ključ za šifrovanje fajla. U suprotnom, ako se dobije šifrovan fajl pri pokušaju d ase on otvori levim klikom miša po fajlu, otvara se dijalog prozor koji nam daje mogućnost da ukucamo tajni ključ. Ukoliko je tajni ključ odgovarajući fajl će se otvoriti.

2.6   Podrške multimedijima u Linux SuSE 

2.6.1   Digitalne video datoteke
MPlayer je kvalitetan program za rad sa multimedijalnim datotekama. Putanja kojom se dolazi do Mplayera je sledeća: Glavni meni →Multimedija→Video→Mplayer. U stanju je da otvori sledeće formate: MPEG, VOB, AVI, VIVO, FLI, DIVX itd.
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               Slika 2.8   MPlayer                                                     Slika 2.9    XMMS
2.6.2   Digitalne audio datoteke
Podrazumevani program za puštanje muzike u Linux distribucijama je XMMS ( X Multimedia Sistem). Putanja je sledeća: Glavni meni→Multimedija→Sound→XMMS.
Kompatibilan je sa Win Amp-om iz Windows-a.

3    PROGRAMSKI JEZICI 
SuSE distribucija Linux operativnog sistema je opremljena bogatim programerskim alatima za razvoj različitih softvera. Podržani su gotovo svi programsi jezici koji danas u svetu predstavljaju standard. 

Perl – jezik optimizovan za pretragu text fajlova, izdvajanje željene informacije iz tih fajlova i sastavljanje izveštaj ana osnovu tih informacija. Takođe je dobar alat za mnoge administratorske zadatke. Jezik je osmišljen kao praktičan (lak za korišćenje, efikasan).

PHP – jezik orijentisan na izradu i upravljanje bazama podataka na internetu. Objektno je orijentisan i lak za korišćenje.

Python – je interaktivni, objektno orijentisani programski jezik. Osnovne funkcije mogu biti proširene sa dodatim modulima napisanim u C ili C++. Ovakvi moduli mogu biti dinamički učitavani (u toku rada programa, kada se ukaže potreba).
Java – objektno orijentisan jezik. Programi napisani ovim jezikom mogu se izvršavati na različitim hardverskim i softverskim platformama. Namenjen je prvenstveno za izradu web aplikacija.

C – moćan strukturni jezik namenjen sistemskom programiranju. Operativni sistem Linux je napisan ovim jezikom.

C++ - Najrasprostranjeniji objektno orijentisani programski jezik. Najpogodniji je za izradu korisničkih aplikacija. Sa C-om spada u najbrže programske jezike. U Linux-u postoje gotovi izvorni kodovi za izradu grafičkog korisničkog interfejsa, koje programer može da koristi bez potrebe da ih ponovo piše, već svoj rad usmerava na specifičnosti primene njegove aplikacije. Primer takvog koda su Qt za KDE grafičko okruženje, ili Glade za GNOME okruženje.

4       RAZVOJ SOFTVERA

Za razvoj softvera u SuSE-u namenjeno je nekoliko alata i nekoliko integrissanih razvojnih okruženja (IDE). Pod IDE-om se smatra softver koji programeru omogućava da piše program, prevodi ga, ispravlja greške, vodi računa o različitim verzijama programa u toku razvoja i meri performanse programa u okviru samo jednog alata. 

Anjuta je prilagodljivo razvojno okruženje za C i C++. Napisan je za GNOME grafičko okruženje i ima brojna napredna programerska sredstva. U Linux-u postoje brojni razvojni alati kojima se ukuje iz komandne linije. Oni su moćni, ali nekada mogu biti teški za korišćenje. Anjuta je pokušaj da se spoji fleksibilnost i snaga ovih alata sa lakoćom korišćenja GNOME grafičkog okruženja.

KDevelop je IDE za KDE grafičko okruženje. Obezbeđuje karakteristike koje su neophodne programerima, ali koristi i eksterne alate kao što su „make“ i GNU C++ prevodilac koji integriše u okruženje tako da korisnik tokom razvojnog procesa ne primećuje da je reč o zasebnim alatima. KDevelop pruža sledeće:

· Sve razvojne alate potrebne za C++ programiranje kao što su kompajler, linker, automake,autoconf
· KAppWizard, za generisanje polaznog okvira aplikacije za razvoj
· Fajl menadžment za izvorne kodove, zaglavlja, dokumentaciju itd.koje treba uključiti u projekat
· Classgenerator, za kreiranje novih klasa i njihovo integrisanje u tekući projekat

· Internacionalna podrška za aplikaciju, koja omogućava prevodiocima da dodaju njihov lokalni jezik i podešavanja

· Kreiranje grafičkog korisničkog intrerfejsa 

· Debagovanje- otklanjanje grešaka uz pomoć alata po izboru: ugrađenih ili nekog drugog proizvođača

5   INTERNET
Linux nudi sve neophodne mrežne alate i karakteristike za integraciju u sve vrste mrežnih struktura. Danas svi moderni operativni sistemi komuniciraju preko TCP/IP protokola mada Linux podržava i druge mrežne protokole. Osnovni alati za povezivanje Linux-a na mrežu, naročito na Internet, putem TCP/IP protokola su:

DNS – Domain Name Service, je neophodan da poveže imena domena i računara domaćina u mreži sa njihovim IP adresama. Za DNS server se koristi aplikacija „named“ iz paketa administratorskih alata BIND. U SuSE distribuciji BIND dolazi već konfigurisan i spreman za upotrebu odmah nakon instalacije. 

NIS – Network Information Service. Kada više sistema u mreži žele da pristupe standardnim resursima, postaje važno da sci korisnički i grupni identiteti budu isti za sve računare u mreži. Mreža treba da bude transparentna za korisnika: koji god da računar u mreži koristi korisnik, on treba da se nalazi u istom okruženju. Ovo se omogućava uz pomoć NIS i NFS servisa. NIS je servis baza koji omogućava pristup /etc/passwd, /etc/shadow i /etc/group širom mreže. Pošto se uz pomoć NIS-a kroz celu mrežu mogu pročitati ovi konfiguracijski fajlovi, korisnik će se naći u istom okruženju na bilo kom računaru u mreži.
NFS – Network File Sistem. Mrežni sistem datoteka, NFS zajedno sa NIS čini mrežu transparentnu za korisnika. Pomoću NFS, moguće je distribuirati fajl sisteme kroz mrežu. Svaki korisnik koji ima dovoljno ovlašćenja može ubaciti udaljeni sistem datoteka u sistem na svom računaru. Na ovaj način uz NIS, korisnik se nalazi u potpuno istom okruženju, sa istim sistemom datoteka, i istim podešavanjima sistema, bez obzira sa kog računara u mreži pristupa Linux mreži.
6        ETHERNET

Ethernet predstavlja najrasprostranjeniji mrežni hardver. SuSE 8.1 kao operativni sistem kome je rad u mrežnom okruženju prioritet, imaju ugrađenu podršku za ethernet kartice i mreže. Konfigurisanje ovog hardvera je izuzetno lako zahvaljujući grafičkom okruženju i YaST-u.

Pri pokretanju YaST-a moraju se imati privilegije administratora sistema.
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                                                     Slika 6.1  Kontrolni centar
Sa leve strane prozora izabere se Network devices, a sa desne Network card. Otvara se dijalog za konfiguraciju mrežnih kartica. U dijalogu postoje dve opcije, za dodavanje novih ili za podešavanje starih.
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                               Slika 6.2  Prozor za konfiguraciju mrežnih kartica
U donjem delu prozora vidi se tip i podešavanja za postojeće kartice. YaST će prepoznati većinu kartica koje se nalaze na tržištu i automatski će za te kartice postaviti najbolja podešavanja. Međutim ako u nekim slučajevima ne prepozna karticu koja se nalazi na računaru, ili ne postavi podešavanja na zadovoljavajući način, to se onda može uraditi i ručno. Klikom na dugme Configure otvara se dijalog prozor za ručno dodavanje i podešavanje kartica.
Svaki  računar u mreži ima svoju adresu. Bez obzira da li je reč o internetu ili lokalnoj mreži, nakon podešavanja mrežnog hardvera, da bi on radio mora mu se podesiti i mrežna adresa.

Postoje dve vrste adresa u mreži: statičke i dinamičke. Statičke adrese se dodeljuju računarima koji su stalno priključeni na mrežu, i na kojima se nalaze serveri. Primeri za statičke adrese su Sendmail za slanje elektronke pošte, Apache server za web strane itd. Računari sa ovim serverima su stalno priključeni na mrežu jer im korisnici moraju stalno pristupati i koristiti njihove usluge, pa su im zato dodeljene statičke adrese. Dinamičke adrese dodeljuje server računarima koji se povremeno uključuju u mrežu ili onim računarima kojima statička adresa nije potrebna.Statičke adrese su veoma dragocen resurs jer kod TCP/IP protokola ima ograničen broj statičkih adresa.

Kada se završi podešavanje adresa otvoriće se prozor koji prikazuje sve mrežne kartice na sistemu. U njemu se mogu promeniti podešavanja pojedinih kartica. Klikom na dugme Finish računar je osposobljen za rad u mreži. 
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                                    Slika 6.3 Prikaz mrežnih kartica na sistemu
      7.        OS I GRAFIČKI INTERFEJS

Rad u Linuxu može se obavljati u :

1)   tekstualnom režimu i
2)   grafičkom režimu
Grafički sistem kod svih Linux distribucija pa i kod SuSE 8.1 temelji se na X serveru.X Window sistem je mreži transparetni grafički sistem koji se može pokrenuti na širokom spektru računarskih i grafičkih uređaja.X server radi na računarima sa bitmapiranim displejima.Server prosleđuje korisnički ulaz programima klijentima,i prihvata njihove zahteve za grafički prikaz na displeju putem brojnih među procesnih komunikacionih kanala.Iako je uobičajen slučaj da se programi klijenti i grafički server pokreću na istom računaru,klijenti mogu da rade i na drugim računarima(uključujući i one sa različitom arhitekturom i različitim operativnim sistemima).

X server je zadužen za prikaz grafike na displeju računara,odnosno predstavlja sredstvo komunikacije između programa i grafičkog hardvera.Međutim on nije zadužen za definisanje izgleda grafičkog prikaza(prozora,ikona i fontova na primer)na ekranu, već samo uslužuje grafičke potrebe programa klijenta.

       Za definisanje izgleda prozora,ikona toolbar-ova i uopšte grafičko šminkanje programa zadužen je Window manager,menadžer prozora.Pošto su menadžeri obični programi klijenti,mogu biti napravljeni najrazličitijikorisnički grafički interfejsi
.

7.1 Prijava iz grafičkog okruženja

       Na prozoru za unos lozinke nalazi se i padajući mani sa listom instaliranih grafičkih okruženja koja su instalirana na računaru, pod nazivom Session type. Ovde birate grafičko okruženje,KDE,GNOME ili pak neko drugo. Grafički pozdravni ekran koji dolazi uz KDE okruženje je KDM(KDE Display Manager) a za GNOME je GDM(GNOME Display)
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                                        Slika 7.1    Odabiranje grafičkog okruženja

7.2 Prijava iz konzole(Virtual Console Login)

 Ako ste tokom instalacije izabrali da se vaš Linux sistem pokreće u tekstualnom režimu na ekranu će pisati ime distribucije i verzija kernela,kao i

localhost login:

Potrebno je da ukucate korisničko ime,pritisnete ENTER,ukucate lozinku i potvrdite sa ENTER. Nakon uspešne prijave na sistem u tekstualnom režimu,možete ući u grafičko okruženje unošenjem komande STARTX.

7.3 KDE grafičko okruženje
KDE je standardno grafičko okruženje za Linux koje pored same radne površine obuhvata i razne druge aplikacije.Ovo okruženje se može instalirati prilikom instalacije operativnog sistema ili naknadno.Standardni paketi KDE okruženja su:

-kdebase-osnova KDE-a i set najvažnijih aplikacija(npr.Konqueror)

-kdeutils-razni pomoćni programi

-kdegraphics-grafički alati(Gimp)

-kdemultimedia-multimedijalni alati(XMMS,Mplayer)

-kdenetwork-mrežne aplikacije 

-kdeaddons-dodatni plugin-ovi za KDE aplikacije

-kdeartwork-dodatni zvukovi i desktop teme 

-kdegames-igre za KDE grafičko okruženje 

-koffice-office aplikacije

Elementi Desktopa
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                                                  Slika 7.2 KDE Desktop
KDE Controlni Centar je mesto gde se podešavaju postavke KDE grafičkog okruženja.Program se može pokrenuti iz Start=>Control Center,nakon toga otvara se glavni prozor sa grupama postavki za podešavanje.U levom prozoru vidimo postavke za podešavanje grupisane u 10 tačaka.U ovom poglavlju pokazaćemo samo neka od podešavanja.
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                                              Slika 7.3 KDE kontrolni centar

U ovom prozoru možete izabrati kompletu šemu boja.(izgled aktivnog/neaktivnog prozora,linkova...)
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        Slika 7.4 Podešavanje boja                                  Slika 7.5 Podešavanje fontova
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       Slika 7.6 Podešavanje ikonica                               Slika 7.7 Podešavanje pozadine
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   Slika 7.8 Podešavanje screen savera                            Slika 7.9 Podešavanje stila
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Slika 7.10 Podešavanje panela                                    Slika 7.11 Podešavanje menija
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       Slika 7.12 Podešavanje prozora                  Slika 7.13 Dodavanje ikonice na panel
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                                            Slika 7.14 Kreiranje prečice
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                                              Slika 7.15 GNOME desktop

7.4       Rad sa slikama u Linux-u

Razlikujemo sledeće programe za rad sa slikama u Linuxsu
              -     programe za pregledanje slika

                    -     programe za crtanje

                    -     programi za obradu slika i fotografija

    7.4.1 Programi za pregled slika 
     Za pregled slika u Linuxsu možemo koristiti više programa,počevši od čitača ugrađenog u Konqueror,pa do programa namenjenih za tu svrhu.Broj njihovih funkcija je vrlo limitiran i po pravilu se svodi na to da na što lakši,ugodniji i brži način omoguće pregledanje velikog broja slika sačuvanih u različitim formatima.Glavna karakteristika ovih programa je broj podržanih formata za čuvanje slika.

Konqueror je program bogat opcijama tako nudi mogućnost čuvanja slike,slanja slike elektronskom poštom.pretragu za sličnim slikama i zaustavljanje animacije kod animiranih GIF ili PNG formata.

Izgled slike otvorene u Konqueroru.
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                                         Slika 7.16 Prikaz slike u Konqueroru

Sliku otvaramo dvostrukim klikom,dok desni klik na sliku otvara padajući meni sa opcijama za manipulaciju slikama.

 7.4.2 Ostali programi za pregled slika
Pored Konquerora postoji mnoštvo programa namenjenih pregledanju slika i jednostavnoj obradi,pomenućemo one koji se najčešće nalaze u distribucijama:

Electric Eyes,Eye of GNOME,QGView,Kuickshow,Kview.

Kuickshow poseduje ugrađen menadžer datoteka za pretragu slika sa podrškom za umanjene prikaze,što olakšava pretragu.Ovaj softver pored manipulacije prikazom i rotacije može menjati kontrast i osvetljenje slike.
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                                                  Slika 7.17 Kuickshow
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                                                  Slika 7.18 Kartica Modifications

7.4.3 Programi za crtanje

Programi za crtanje namenjeni su kreiranju jednostavnih skica i crteža. Kao takvi nisu predviđeni za obradu fotografija premda neki od njih imaju ugrađene i neke jednostavnije funkcije pomoću kojih se može izoštriti slika. U ovom poglavlju pomenućemo program KPaint.To je jednostavan program za crtanje sličan programu Paint iz MS Windows okruženja.

7.4.4 Programi za obradu slika

Programi za obradu slika namenjeni su za editovanje fotografija i obradu plakata,naslovnih strana časopisa, omota za audio CD-ove i sl.Za razliku od programa za pregledanje i programa za crtanje koji se ne razlikuju previše po svojoj funkcionalnosti, programi za obradu fotografija variraju u broju funkcija za obradu slike koje pružaju. Postoje jednostavni editori (npr.ImageMagick), i napredni editori namenjeni za profesionalnu primenu kao što je stono izdavaštvo, izrada plakata ili profesionalna obrada fotografija.

U ovom poglavlju opisan je GIMP profesionalni editor slika koji je u rangu s Adobe PhotoShop, Corel PhotoPaint editorima u MS Windows okruženju.GIMP osim alata za crtanje ima i mnoštvo funkcija za obradu i retuširanje fotografija tako da ga mogu koristiti obični korisnici,ali i profesionalci.Glavna funkcija GIMP-a je editovanje bitmapa, ali s njim dolaze i alati za rad s vektorskom grafikom. Neke opcije za obradu slike u GIMP-u pogodne su i za izradu kratkih animacija koje se mogu sačuvati u obliku animirane GIF slike ili u MPEG formatu.rad sa slojevima i kanalima takođe je implementiran,a postoji i podrška za alfa kanal.Iz tog razloga GIMP se smatra standardom za obradu slike u Linux okruženju.U ovom poglavlju dat je kratak uvid u mogućnosti ovog programa.S GIMP-om dolazi i priručnik za korištenje u kojem su detaljno opisane sve njegove funkcije i koji se može koristiti za detaljne informacije.GIMP dolazi standardno sa svim Linux distribucijama tako da je postupak njegove instalacije vrlo jednostavan.Prilikom startovanja Gimpa osim glavnog prozora otvaraju se:

    - prozor za manipulaciju sa slojevima

     -prozor za konfiguraciju odabranog alata 

    -   prozor za odabir kista 

    -prozor u kom je prikazana slika koja se trenutno obrađuje

U glavnom prozoru programa se nalazi i traka za izbor alata,izbor trenutno aktivne boje i načina popune bojom.
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           Slika 7.19 GIMP(glavni prozor)
                          Slika 7.20 Gradient
 U prozoru za manipulaciju slojevima odabira se sloj koji se trenutno obrađuje,slojevi koji će biti prikazani na ekranu,slojevi koji se stapaju u novi sloj i sl.
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Slika 7.21 Prozor za manipulaciju slojevima            Slika 7.22 Prozor za odabir kista
U prozoru za izbor kista selektuje se trenutno aktivni kist za crtanje. Već postojeći kistovi mogu se menjati ili se mogu dodavati novi.
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                   Slika 7.23 Prozor u kom je prikazana slika koja se trenutno obrađuje

       U prozoru za editovanje prikazana je slika koja se trenutno obrađuje. Pritiskom na desni taster miša bilo gde u ovom prozoru pojavljuje se padajući meni preko kojeg su dostupne mnoge dodatne opcije za obradu slika. Preko ovog menija su dostupni i svi filtri koji dolaze sa GIMP-om, kao i opcije za podešavanje kontrasta, boja i mnoge druge. 

      8.       UPRAVLJANJE POSLOVIMA, PROCESIMA, PROCESORIMA

Procesi su jedan od najznačajnijih koncepata operativnih sistema. Program se može objasniti kao niz instrukcija koji ostvaruje neki algoritam. Proces je program u statusu izvršavanja uključujući i sve resurse koji su potrebni za rad programa. Program tumačimo kao fajl- nakon učitavanja fajla u memoriju i početka njegovog izvršavanja dobijamo proces.
Proces možemo definisati i kao sistemsku sredinu koju kreira Linux kernel kao posledicu aktiviranja programa. Kod Linix operativnih sistema razlikujemo tri tipa procesa:

· Interaktivni procesi koji se kontrolišu preko konzole. Izvršavaju se u foreground ili background modu

· Batch procesi se izvršavaju u batch obradi, zahtevaju dosta procesorskog vremena i zagušuju sistem

· Server procesi se izvršavaju u pozadini. Ovi procesi se nazivaju daemons.

Proces se izvršava ili u korisničkom, ili u kernel modu.U korisničkom modu instrukcije se izvršavaju u neprivilegovanom modu hardvera. Kada proces zatraži od kernela neki sistemski poziv, instrukcije se vrše u privilegovanom, ali kernelom ograničenom i kontrolisanom modu. Na ovaj način su aplikacije odvojene od hardvera.

Kernel razlikuje procese prema njihovom proces identifier(PID) broju. Korisnici mogu kreirati procese, kontrolisati izvršavanje procesa i primiti obaveštenja kada se status izvršavanja procesa promeni.

Kernel koristi sledeće za izvršavanje procesa (PID, prioritet, stanje izvršavanja, data, stack i text segmente, stanje signala, akcije na signale, tajmere, deskriptore, ...). Kernel odlučuje koji će proces sledeći da se izvršava- ovo se naziva scheduling ili vremensko planiranje. Zadatak kernela je da isplanira izvršavanje procesa tako da svi procesi mogu da zauzmu podjednako resursa. Programi se ocenjuju prema količini računanja i količini I/O koje izvršavaju i na osnovu toga im se određuje prioritet. Prioritet u Linux operativnim sistemima se izračunava svake sekunde na osnovu količine memorije koju zauzima, ukupne zauzetosti resursa sistema i vrednosti nice koju ima svaki proces i koja označava poželjni prioritet.

8.1    Ograničavanje resursa

Kernelpodržava ograničavanje količine resursa koji su dostupni pojedinačnim procesima. Ova ograničenja mogu biti: maksimalno CPU vreme koje proces može da zauzme , količina memorije koju može da alocira, veličina i broj fajlova koje proces može da kreira, broj simultanih procesa koje korisnik može da pokrene i dr. Za svako ograničenje postoje soft (mekani) i hard (čvrsti) limit. Kada proces pređe soft limit, stiže mu signal koji obično rezultira prekidanjem izvršavanja procesa, ali proces može i da ignoriše ovaj signal i pokuša da oslobodi resurse. Ukoliko to ne uspe sledeći pokušaj alociranja još resursa neće uspeti. Hard limit se ne može prekoračiti. Svi korisnici mogu svojim procesima da smanje hard limit, a jedino superuser može da ga poveća.

Elemente svakog procesa možemo podeliti u tri grupe:

· tekst segment programa (segment sa instrukcijama)
· data segment programa

· data segment sistema

Sadržaj data segmenta definiše program (uspostavljanje početnih vrednosti promenljivih). Program definiše i sadržaj text segmenata (programske instrukcije). Data segment sistema sadrži informacije o nazivima direktorijuma, brojevima aktivnih datoteka itd.
8.1.1   Atributi procesa

Svaki Linux proces poseduje sledeće atribute:

· ID vlasnika

· naziv procesa

· ID procesa (PID)

· stanje procesa

· PID procesa roditelja

· vreme u komje proces pokrenut

Sa stanovišta korisnika najznačajniji od tih atributa je PID koji se koristi kao parametar u nizu naredbi za kontrolu procesa.

8.2     Izvršavanje naredbi ljuske (shell commands)

Shell (ljuska) je omotač oko jezgra operativnog sistema, kernela. U Unix sistemima se dosta posla obavlja iz komandne linije (command line). Korisnički i sistemski programi se pokreću komandnim interpretorom. U Unix-u je shell korisnički proces čiji je zadatak da prima komande od korisnika i da ih izvršava.

Kratak opis najčešćih shell-ova:
1)   sh – Bourne-Shell – jedan od prvih shell-ova koji su napisani. I danas se dosta koristi, pogotovu za pisanje skripti (za startovanje i gašenje sistema)

2)   csh – C-Shell – standardni shell Berkeley-evih distribucija, prvi shell sa istorijom komandi i sintaksom u stilu C-a. Napisao ga je Bil Joy.
3)   ksh – Korn-Shell – standardni shell UNIX System V, prvi shell sa editovanjem komandne linije korišćenjem drugih programa (vi, emacs).

4)   bash – Boune-Again-Shell – moderni naslednik sh-a, koristi se za skripte 

5)   tcsh – Turbo-C-Shell – moderni naslednik csh-a, lako prilagodljiv 

Shell je takođe i programski jezik visokog nivoa. U njemu se mogu pisati skripte koje se mogu pokretati kao obične komande.

Naredbe ljuske mogu biti interne i eksterne.

Interna ili ugrađena naredba (internal or built-incommand) je naredba čiji je kod deo procesa ljuske. Neke od internih naredbi Linux ljuske su pwd, cd, time, echo, jobs, bg i fg.
Eksterne komande su one čiji se kod nalazi u nekoj drugoj datoteci (programu). Sadržaj druge datoteke može biti binarni kod ili skripta ljuske (shell script). Neke od uobičajenih eksternih naredbi su grep, more, cat, mkdir, rmdir, ls,sort, ftp, telnet, lp i ps.

Ljuska kreira novi proces da bi izvršila eksternu komandu. Dok se pokrenuti proces izvršava ljuska čeka na njegov kraj.

C shell sistema pruža kontrolu poslova (job control) koja omogućava prebacivanje poslova iz prednjeg u zadnji plan, stopiranje i restartovanje poslova. Ovo je našlo primenu i u X-Windows-u, grafičkom korisničkom interfejsu gde se svaki prozor smatra terminalom i može postojati više programa koji će biti u prvom planu.

8.3 Upravljanje Linux-om u X-okruženju
Pored praćenja procesa iz konzole, postoje programi koji rade pod X okruženjem i pružaju važne sistemske informacije.

8.3.1 Procman System Monitor

Ovaj program daje prikaz/listu procesa, korisnike, podatke memoriji, iskorišćenosti CPU... Program takođe omogućava pregled svih procesa, trenutno aktivnih ....
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                                    Slika 8.1  Procman System Monitor

 Za promenu prioriteta mora se ići sledećom putanjom:
Desni taster na proces→Change Priority ili Edit→Change Priority
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                                              Slika  8.2  Promena prioriteta

Prioriteti se kreću od -20 do 20.

8.3.2   GNOME System Monitor

Gnome System Monitor- program daje informacije o zauzeću memorije i popunjenosti hard diska.
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                                       Slika 8.3   GNOME System Monitor 

8.3.3     KDE Task Manager

Još jedan program namenjen za KDE okruženje, koji daje pregršt sistemskih informacija.
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                                               Slika 8.4  KDE Task Manager

8.4 Linux Daemons

Bez obzira što se svaki proces koji se pokrene u pozadini može nazvati daemon, u Linux sistemu deamon je sistemski proces koji je pokrenut u pozadini. Daemon procesi se najčešće koriste u Linux sistemu za pružanjerazličitih servisa korisnicima ili obavljaju sistemske administrativne poslove. Npr. Web servisi su omogućeni od strane daemon procesa. E-mail servis je omogućen preko smtpd daemona, a web servis preko httpd daemona.   
9.       PERIFERIJSKA OPREMA 
U najčešće korišćenu periferijsku opremu ubrajaju se tastatur, miš, štampači, skeneri i periferijska oprema za multimedije. Upravljanje ovim periferijama je krajnje pojednostavljeno u SuSE distribuciji kroz YaST program. Podešavanje kodnog rasporeda tastature usko je povezano sa izborom jezika, odnosno raspored tastera se automatski pridružuje izboru jezika za Linux sistem ( Yast Control Centar→System→Choose Language), mada se može izabrati i nezavisno (Yast Control Centar→System→Select Keyboard Layout).
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                                             Slika 9.1 Podešavanje tastature

Podešavanje tastature se izvodi putanjom: Glavni meni → Kontrolni centar→Periferije→ Tastatura

U Linux sistemima prilikom štampanja kao standard usvojen je PostScript jezik koji opisuje izgled štampane strane. Najveći broj aplikacija, kada od sistema zahteva štampanje, koristi ovaj jezik za opis štamparskog posla. Ukoliko je na računar povezan PostScript štampač onda se podaci direktno šalju na štampač i štampaju. Međutim, postoje štampači koji ga ne podržavaju, pa se koristi program Ghostscript koji PostScript stranu konvertuje u druge standardne jezike (PCL3, PCL4, PCL5e, PCL6 itd). Ghostscript koristi različite drajvereza različite štampače kako bi bilje koristio osobine konkretnog štampača, kao što su naprimer osobine  njegovih boja. Pošto Linux drajverew ne pišu proizvođači hardvera, vrlo je bitno da se štampačem upravlja pomoću nekih od standardnih štamparskih jezika. Međutim, u slučaju jeftinih GDI štampača to nije moguće. Ovi štampači koriste nestandardne kontrolne kodove i vezani su za operativni sistem za koji je proizvođač napisao drajver (uvek Windows OS). Ovakva izrada štampača smanjuje njihovu ali ih vezuje za Windows operativni sistem. Postoji mali broj GDI štampača koji se mogu koristiti u Linux-u. Za kontrolu štampanja u SuSE Linux-u koriste se dva softverska sistema: LPRng i CUPS. Ova dva sistema su u međusobnom konfliktu pa ne mogu oba biti instalirana istovremeno.
Podešavanje parametara štampača:

Glavni meni→Kontrolni centar→Periferije→Printers
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                                                        Slika 9.2  Dijalog prozor Printers

Podešavanje miša:
Glavni meni→Kontrolni centar→Periferije→Miš
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                                                  Slika 9.3      Podešavanje miša

Izborom Yast→Control center→Hardware→Scanner SuSE će automatski konfigurisati skener. Naravno, ukoliko je priključen na računar, ako je reč o USB ili SCSI skeneru, i ako je podržan drajverima.
10.     KONFIGURISANJE RAČUNARSKOG SISTEMA I INTERFEJS
Prvi interfejs sa kojim se običan korisnik susreće je grafički ili tekstualni interfejs koji mu omogućuje interakciju, zadavanje zadataka kernelu oprativnog sistema Linux i dobijanje povratne informacije. tako se interfejs može shvatiti kao veza između korisnika i kernela operativnog sistema. Interfejs je takođe potreban i prilikom komunikacije između herdverskih komponenti računara i kernela.
Hardverske komponente se bitno razlikuju od računara do računara, a kernel mora biti sposoban da upravlja svakom od njih. Zato se mora definisati i interfejs za svaki tip hardvera koji se može naći u računaru. Ako OS nema interfejs za konkretnu hardversku komponentu tada nema ni komunikacije između njih. Konkretno drajveri predstavljaju interfejse za pojedine hardverske komponente. Svaka komponenta računara mora imati svoj interfejs, od tastature i miša, preko monitora i grafičke kartice pa sve do hard diska, memorije i CPU-a.

Postoje hardverski i softverski interfejsi. 
Primer za hardverski interfejs je Ethernet kartica, mrežni interfejs, čije je rukovanje objašnjeno u poglavlju o mrežama. Naime, svi računari u mreži komuniciraju međusobno istim jezikom koji je definisan mrežnim protokolom. Najčešći protokol za heterogene mreže je TCP/IP. Kada neki računar želi poslati podatke u mrežu on to radi preko Ethernet kartice. Računar šalje na karticu podatke koji su samo njemu razumljivi, a ova ih prevodi u TCP/IP protokol koji razumeju svi ostali računari u mreži.

Softverski interfejsi predstavljaju programe, drajvere, napisane tako da se ne mogu samostalno izvršavati, već se oni na različite načine ugrađuju u kernel čime postaju njegov sastavni deo i proširuju mu funkcionalnost. Omogućavaju i pisanje u različite fajl sisteme, pružaju podršku za hardverske komponente, zvučne i mrežne kartice, monitore i modeme. U Linux-u se ovi programi nazivaj moduli, U zavisnosti kako se moduli ugrađuju u kernel razlikujemo dve vrte kernela:
· monolitni i

· modularni.

Kod monolitnog kernela u njegov izvorni kod ubaci se kod svih modula koji se žele uključiti u kernel. Zatim se takav kernel kompajlira. Mana ovog kernela je to što on može da podrži samo onaj hardver za koji su mu dodati interfejsi pre kompajliranja. Mana je i veće zauzeće memorije jer se svi moduli nalaze u memoriji zajedno sa kernelom, bez obzira da li se trenutno koriste ili ne.

Modularni kernel nema u sebe ugrađene module već se oni u toku rada pojedinačno učitavaju. Kada se Linux pokrene učitavaju se samo moduli za sve hardverske komponente koje se nalaze u računaru, i ovi interfejsi postaju sastavni deo kernela. Dalje, u toku rada, akose ukaže potreba da se pročita bilo koj adisk particija učitava se odgovarajući moduli kernelu postaje dostupan interfejs za taj fajl sistem.Kada se ta particija ne bude više koristila uklanja se i modul, tako da ne zauzima meto u memoriji. Prednost ovog kernela ja manje zauzeće memorije i mogućnost dodavanja nove hardverske komponente u svakom trenutku.Mana mu je sporiji kernel i manja stabilnost i pouzdanost.
Učitavanje modula, njihovo uklanjanje i sve druge manipulacije sa njima omogućeno je isključivo root korisniku. Ukoliko se žele pregledati koji su trenutno učitani moduli u kernel treba u konzoli izdati naredbu „ismod“ i na ekranu će biti izlistani postojeći moduli.

Za instaliranje novog modula u već pokrenuti kernel komanda je 

insmod imemodula,
a komanda za uklanjanje modula je

rmmod imemodula.

Za napredniju kontrolu učitavanja modula u Linux-u služe naredbe depmod i modprobe kao i konfiguracioni fajl modules.conf koji se nalazi u /etc direktorijumu.

10.1    Hardverski zahtevi za SuSE 8.1

SuSE 8.1 se može prilikom instalacije prilagoditi najrazličitijem spektu korisnika. Zato minimalna hardverska konfiguracija zavisi i od zahteva samog korisnika. Za korišćenje SuSE distribucije u kancelarijske svrhe, za obradu teksta i surfovanje po Internetu, bez paralelnog pokretanja zahtevnijih aplikacija, minimalna konfiguracija bila bi:
1. Procesor u klasi Pentium I (Intel ili AMD)

2. 64MB memorije

 Već sa ovom konfiguracijom korisnik bi mogao da pokrene SuSE sa KDE grafičkim okruženjem. Ovaj rad na ovako konfigurisanom računaru je daleko od udobnoga u pogledu brzine prilikom paralelnog izvršavanja više aplikacija. Pa zato, za minimum praktičnog korišćenja sistema u kancelarijskim i školskim uslovima bila bi potrebna sledeća konfiguracija:

1. Procesor Pentium II na 400MHz

2. 128MB memorije

Prostor koji bi zauzimala minimalna instalacija bio bi oko 400MB pri čemu ne bi bile instalirane brojne aplikacije za obradu teksta i grafike, za multimediju i programski razvoj. Standardna instalacija zauzima 1.5GB u zavisnosti od želja korisnika, i da li želi da na svoj računar instalira više različitih grafičkih okruženja i koliko dokumentacije.
Izbor kompletne instalacije, svih programa, dokumentacije i grafičkih okruženja koji se nalaze na instalacionim CD-ovima zauzeo bi preko 6GB prostora.

Sadržaj distribucije:

Distribucija SuSE Linux 8.1 dolazi u dve varijante: Personal i Proffesional na 7 CD-ova ili na jednomDVD disku. U sklopu ovog paketa nalaze se i dva priručnika:

1) User quide

2) Administration quide

U priručniku za korisnike nalaze se uputstva o instalaciji, konfiguraciji kao i uputstva za korišćenje programa poput Gimpa, Evolucije, OpenOffice-a i drugih.

Priručnik za administriranje sadrži poglavlja o kernelu, mrežnim postavkama, sigurnosnim opcijama kao i detaljno objašnjenje konfigurisanja i instalacije.
Sama instalacija je pojednostavljena korišćenjem YaST2 programa koji funkcioniše na principu čarobnjaka.

1. Na prva četiri diska nalaze se verzije paketa, a na ostala tri izvorni kod

2. Kernel dolazi u verziji 2.4.19

3. XFree86 4.2.0 sa podrškom za novije grafičke kartice 

4. Grafičko okruženje KDE 3.0.3, GNOME 2.0.6-60

5. Biblioteka za razvoj u programskom jeziku C Glibc 2.2.5

6. Web-server Apache:1.3.26 kao i Samba, NIS, NFS serveri

7. Od kancelarijskih programa na raspolaganju su KOffice1.2 i OpenOffice 1.0.1

8. Netscape 4.80, Mozilla 1.0.1, Konqueror, Opera, Galeon....

11.     UPRAVLJANJE MEMORIJOM U LINUX OPERATIVNIM SISTEMIMA
11.1     Korišćenje spoljnih memorija u Linux operativnom sistemu

Centralni deo operativnog sistema zauzima sistem za manipulisanje memorijom (memory managment system). On je zadužen za kontrolisanje memorijskih resursa koji su dostupni mašini. Primarna (glavna) memorija je RAM memorija računara, a sekundarna je svaki drugi medijum za čuvanje podataka (hard disk, CD ROM,..).

Svaki program ima svoj privatni adresni prostor. On se sastoji iz data, text i stack segmenata. Data segment sadrži inicijanizovane i neinicijanizovane podatke programa. Text segment sadrži mašinske instrukcije i dele ga svi procesi koji iozvršavaju taj fajl, dok su data i stack segmenti privatni za svaki proces. U stack segmentu se nalazi run-time stack program i njega kernel automatski proširuje dok se program izvršava. Data segment može biti proširen ili skupljen pozivanjem sistemskog poziva, dok veličina i sadržaj text segmenta mogu jedino biti promenjeni prilikom pozivanja sistemskog poziva execve, kada se postojeća memorijska slika prepisuje nekom drugom i stvara se novi proces.

Prilikom započinjanja izvršavanja nekog programa, kernel prvo učita text segment programa na početak adresnog prostora. Posle toga kernel mapira inicijalizovane podatke data segmenta i nulira ostatak adresnog prostora (koji je veličine neinicijalizovanih podataka i stack-a). Iako to nuliranje nije neophodno (čak je i suvišno jer usporava učitavanje programa) rani UNIX sistemi su to ostavili u nasleđe.

Koriranje celog text segmenta i inicijalizovanih podataka u memoriju mnogo usporava proces inicijalizovanja programa. Adresni prostor se deli na stranice jednakih veličina, a kernel vodi računa o adresama stranica koje su učitane. Kada program pokuša da pristupi stranici koja nije učitana javi se page-fault trap u kernelu, page-fault trap handler učita dotičnu stranicu i program nastavlja sa izvršavanjem. ovako su u memoriju učitavaju samo delovi programa koji se koriste.

Usled primene multiprogramiranja neophodno je da operativni sistem efektno deli memorijske resurse među procesima. ceo adresni prostor procesa nemora u svakom trenutku biti prisutan u primarnoj memoriji da bi se proces izvršavao. Ukoliko su memorijski resursi sistema niski, kernel sprovodi neki od mehanizama za oslobađanje resursa. Kernel može izbaciti stranice koje nisu dugo bile upotrebljavane (paging), ili može ceo kontekst procesa prebaciti u sekundarnu memoriju (swaping). Straničenje na zahtev i zamena stranica su transparentni za procese, ali procesi mogu pružiti sistemu informacije o budućim memorijskim zahtevima, radi poboljšanja performansi.

Dobra strana memory management-a je to što omogućava da postoji više procesa nego što može da se smesti u primarnu memoriju, a loša to što se izvršavanje procesa usporava. Sistem mora da se pobrine da minimizuje trashing. To je pjava kada sistem više vremena troši da izvrši zamenu stranica, nego što troši na korišćenje tih stranica. Sistem detektuje trashing tako što posmatra količinu slobodne memorije. Ukoliko postoji mali broj slobodnih stranica, a veliki je broj zahteva za alociranje memorije, sistem blokira izvršavanje određenog broja procesa koji zauzimaju dosta resursab i prebacuje ih u sekundarnu memoriju. Kada zagušenje prođe, blokirani procesi se vraćaju u glavnu memoriju i nastavljaju sa izvršavanjem.

11.2     Spoljne memorije

Pod spoljnim memorijama smatraju se sve vrste diskova (flopi diskete, CD ROM i DVD diskovi, hard diskovi) i razne USB prenosive memorije i USB diskovi. Pošto je Linux višekorisnički operativni sistem postoji realna opasnost da ukoliko jedan korisnik, recimo ubaci disketu u računar, da neki drugi korisnik, iz neznanja izvadi disketu iz računara i tako ugrozi podatke drugih korisnika, pa i stabilnost celog sistema. Zato je u UNIX operativnim sistemima uveden pojam „montiranja“ svih spoljnih memorija. Da bi se spoljna memorija koristila mora se prethodno montirati u sistem.

Administrator sistema definiše koje se sve spoljne memorije mogu montirati na sistem, mko od korisnika ima pravo da ih montira i na koji način se vrši njihovo montiranje, da li će se sa njih samo čitati podaci ili će se na njih i upisivati, kao i koji korisnici mogu da čitaju a koji da upisuju podatke. I na kraju, koji korisnik može da ukloni spoljnu memoriju iz sistema, što doprinosi bezbednosti podataka na njoj i samog Linux sistema.
Nakon što se završi sa korišćenjem prenosive memorije ona se mora demontirati sa sistema. Ukoliko se recimo flopi disketa izvadi iz računara pre demontiranja, može se desiti da podaci koje je korisnik snimao na disketu budu pokvareni i neupotrebljivi. Naime, možda se podaci nalaze u baferu računara, pa zbog preranog uklanjanja prenosivog medijuma kernel neće biti u mogućnosti da te podatke snimi. Demontiranjem nalažemo kernelu da te podatke iz bafera snimi na medijum.

Interesantan je primer CD diska koji se ne može izvaditi iz računara pre demontiranja.

11.3    Montiranje i demontiranje

U KDE grafičkom okruženju, montiranje uređaja se vrši tako što se desnim tasterom miša klikne na ikonu koja predstavlja uređaj na destopu, i iz menija izabere „mount“ ili „montiraj“ , zavisi od jezika koji se koristi. Ukoliko želimo da vidimo sadržaj uređaja levim tasterom miša kliknemo na ikonu i otvoriće se sadržaj u Konqueror fajl menadžeru.

Drugi način montiranja je klik levim tasterom miša na ikonu uređaja i on će automatski biti montiran i sadržaj otvoren u fajl menadžeru.

Demontiranje uređaja se vrši tako što se desnim tasterom miša klikne na ikonu koja predstavlja taj uređaj na desktopu, i iz menija izabere „unmount“ ili „demontiraj“.
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                                                      Slika11.1  Montiranje dikete
U tekstualnom režimu montiranje uređaja se vrši pomoću naredbe“mount“ koja se poziva na sledeći način: 

     mount –t tip uređaj direktorijum 
     tip – fajl sistema na uređaju koji se montira FAT16, FAT32,...
    uređaj – koji se montira.  /dev/cdrom – CDROM

                                             /dev/hda1 – prva particija na prvom hard disku itd...

     direktorijum – tačka montiranja, na kome se montira uređaj

Po završetku rada sa uređajem potrebno ga je demontirati sa sistema pre nego se i fizički ukloni sa računara. Ovaj postupak može se uraditi u konzoli unosom komande unmount direktorijum.
11.4       Formatiranje diskete

Putanja:  Glavni meni→Sistem→Tools→KFloppy
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                                                          Slika 11.2  KFloppy
Dijalog prozor na slici 11.1 prikazuje opcije koje odgovaraju pripremi diskete za rad pod Linix operativnim sistemom. Ukoliko želite da sadržaj diskete bude vidljiv iz Windows sistema, polje gde stoji ext2  treba promeniti u DOS. 

12.     SuSE 8.1 APLIKACIJE

Uz distribuciju SuSE 8.1 ide standardni OpenOffice.org koji predstavlja skup korisničkih programa po svojoj funkciji veoma sličnih Microsoft Office koja ide uz verzije Windowsa. Proizvođač OpenOffice-a je Sun.OpenOffice.org obuhvata sledeću grupu aplikacija:

· OpenOffice.org Impress

· OpenOffice.org Draw

· OpenOffice.org Calc

· OpenOffice.org Writer

· OpenOffice.org Math
12.1   OpenOffice.org Impress

To je softver za izradu prezentacija po svojoj funkcionalnosti može se uporediti sa PowerPoint-om iz Windowsa. Poseduje skoro identične alate za izradu prezentacija, OpenOffice.org Impress je potpuni alat za izradu prezentacija  koji omogućava izradu i prepravljanje dijagrama, grafikona i slika u samom programu tako da poznavaoci PowerPoint-a neće imati problema prilikom korišćenja ovog softvera.
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                                              Slika 12.1  OpenOffice.org Impress

Putanja do programa:  Glavni meni→Kancelarija→Presentation→OpenOffice.org Impress

U prethodnom prozoru bira se tip prezentacije:

   1. Prazna prezentacija

   2. Ponuđeni šablon

   3. Mogućnost otvaranja postojeće prezentacije

Nakon odluke za neki od ponuđenih tipova, pristupa se izradi prezentacije.

Sve mogućnosti PowerPoint-a koje ste izučavali mogu se primeniti i ovde. Postoji velika galerija znakova za nabrajanje, pozadina, zvukova koji se mogu iskoristiti. OpenOffice.org takođe raspolaže širokim spektrom efekata koji prezentaciji daju interesantniji izgled.

Putanja do galerije: Tools→Galerija 

Novi slajd u galeriju se dodaje:  OpenOffice Impress→Meni→Insert→Slide  otvoriće se dijalog u kome se mora dat naziv slajdu i izabrati njegov dizajn.

Efekti na slajdu, prelaz između slajdova ili objekata na slajdu dodaju se uz pomoć dijaloga Effects koji se otvara putanjom OpenOffice Impress→Meni→Slide Show→Effects. Iz tog dijaloga izabere se grupa efekata, a zatim i sam efekat.

Svaki rad treba sačuvati. OpenOffice Impress podržava najrazličitije formate za snimanje dokumenata. Najbitniji je Microsoft Office PowerPoint format .ppt. Dijalog za snimanje prezentacija dobija se putanjom OpenOffice Impress→File→Save As....  Format snimanja izabira se iz padajućeg menija.

12.2    OpenOffice.org Writer

Ovaj softver se može uporediti sa Microsoft Word-om iz Windowsa. OpenOffice.org Writer je napredni tekst procesor. Snažna navigacija i alat za podešavanje interfejsa čine izradu ili izmenu bilo kog pisanog dokumenta vrlo jednostavnom operacijom.
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                                           Slika 12.2 OpenOffice.org Writer

Writer omogućava kompletno formatiranje teksta sa svim tehnikama kojima raspolaže i Microsoft Word. Na raspolaganju su svi neophodni alati za formatiranje teksta. 

Putanjom OpenOffice Writer→Meni→Format→Character... otvara se dijalog za izbor fontova, veličine, orijentacije teksta i raznih drugih efekata.

OpenOffice.org Writer podržava najrazličitije formate za snimanje dokumenata. Najvažniji su :   1. Microsoft Word .doc format

   2. Običan .txt format

   3. Adobe .pdf format

   4. Sopstveni XML format .sxw

   5. „Bogati tekst format“ .rtf
Ovi formati mogu se učitavati ili u njima snimati rad. Dijalog za snimanje dokumenata dobija se putanjom OpenOffice Writer→File→Save As....  Format za snimanje izabira se iz padajućeg menija.

Štampanje dokumenata se vrši putanjom OpenOffice Writer→File→Print... otvara se dijalog prozor za štampanje. Ovde može da se izabere štampač na kom će se štampanje obaviti. 

Adobe .pdf format omogućuje da vaš dokument bude jednako prikazan ili odštampan na različitim softverskim i hardverskim platformama.

12.3   OpenOffice.org Calc
Softver za tabelarna izračunavanja. Pandam Microsoft Excelu
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                                                Slika 12.3  OpenOffice.org Calc 

12.4   OpenOffice.org Math

Softver koji omogućava matematička izračunavanja.
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                                             Slika 12.4  openOffice.org Math

12.5   OpenOffice.org  Draw

OpenOffice.org Draw je alat za izradu grafike koji podržava vektorske i bitmap tipove slika. Široki izbor konektora omogućava izradu kompleksnih dijagrama i organizacionih grafikona. Podržana je i izrada 2D i 3D grafike. Softver za crtanje po funkcionalnosti može se uporediti sa CorelDraw softverom.
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                                        Slika 12.5  OpenOffice.org Draw

Korisno je pomenuti i KOffice koji je deo KDE grafičkog okruženja.  

Putanja: Glavni meni→Kancelarija→KOffice Workspace
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                                                    Slika 12.6  KOffice 
                                                                Zaključak

Prednosti i preporuke za korišćenje Linux SuSE 8.1 operativnog sistema

· Mogućnost rada u konzoli (rad u konzoli je osnovni aktivni rad, bez učitavanja drajvera i aplikacija koje su zadužene da budu aktivne pri radu sa grafičkim interfejsom). Linux ima mogućnost rad sa 6 konzola istovremeno, aktiviranjem tastera F1,F2,F3 mogu se menjati konzole i obavljati različite operacije
· Različiti prioriteti korisnika: glavni prioritet ima root korisnik, ostali korisnici su podređeni root korisniku koji ima najveća prava i odgovoran je za sistem
· Linux vidi particiju hard diska koja je pod Windowsom, dok se iz Windowsa ne može uticati na Linux particiju
· Sigurnost na internetuu pod Linux-om je veoma diskutabilna i usko povezana sa predmetom rada
· Linux i UNIX operativni sistemi ubrajaju se u najstabilnije sisteme
· Preporučuje se za rad u LAN mrežama
· Linux zahteva „lokalhost login“ – korisničko ime i password su case sensitive. Svaki uspešan i neuspešan pokušaj logovanja ostaje zabeležen u jednom fajlu. Ne ostoji način da se pristupi korišćenju sistema osim pravilnog logovanja
· Pristup sistemskim direktorijima ima samo root korisnik
· Linux radi na dva nivoa: u shell-u, to jest školjki sistema i kernelu ili jezgru sistema. Važno je razlikovati verziju Linuxa i verziju kernela
· Linux karakterišu dozvole za čitanje, pisanje/brisanje i izvršavanje
· Linux i svi UNIX based operativni sistemi ne koriste ekstenzije kao što je slučaj sa Windows i DOS operativnim sistemima
· Interesantan grafički interfejs, najpoznatiji KDE i Gnome
· Najpoznatija i jedna od najčešćih mana Linuxa su drajveri, problemi se najčešće javljaju prilikom korišćenja softverskih modema kojima Linux ne može da pruži adekvatnu softversku podršku
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